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Introduction

Thank you very much for selecting Grimm Audio's LevelOne for your audio normalizing tasks. This program is build to
support one of the most important achievements in the audio industry for decades: the change from peak normalization
to loudness normalization. This "true audio revolution" started when the ITU submitted the BS.1770 'LKFS' (also known as
LUFS) loudness metering standard in 2006. The European Broadcast Union EBU took the lead in building a broadcast
recommendation upon this fundament, called R128. It was released in 2010. Eelco Grimm of Grimm Audio was one of the
active members of the EBU PLOUD committee that created the recommendation. The committees work has been made
possible by the aid of a piece of software developed by Grimm Audio's Wouter Snel and Jorn Lemon. This means LevelOne
is the extended version of the actual software that made R128 happen. We are very proud to offer you this great piece of
software that will enhance your daily work spectacularly.

Applications

LevelOne is at home in many applications. File preparation for broadcast delivery during AV postproduction is of course
the most obvious application. Broadcast stations around the world start using ATSC and EBU recommendations and the
demand for material to be compliant will grow rapidly. Using LevelOne for the official loudness normalization before
deliverance is a huge time saver. But there are more uses for this powerful technology. For instance LevelOne can be used
to loudness normalize raw material received from different reporters and thus automatically avoid loudness jumps when
editing an item. In small scale broadcast stations LevelOne can even serve as part of an ingest system. But also outside the
broadcast world LevelOne makes life a lot easier. In multimedia and game audio production LevelOne can be used to
match the loudness of dozens of files. The preset setup facilitates different target levels for different kinds of sound
content. Last but not least in music mastering LevelOne can safe a lot of time by normalizing the files of a compilation cd
or even a whole music downloads website, or help prevent distortion thanks to its True Peak measurement.

Working with LevelOne

The best way to mix audio files for broadcasting in the new paradigm may at first seem quite dangerous. Basically you just
lower your modulation levels, ignore your meters and focus on the sound. Once in a while you take a glimpse at the digital
peak meter to make sure you are not clipping. Don't be afraid that you will loose resolution by modulating low, with
current 24 bit high resolution equipment this is no threat anymore.

If you feel insecure working without visual feedback, please consider using a realtime EBU mode loudness meter.
Alternatively use your VU's or PPM's but align them correctly. A proper alignment for your VU meter would be 0 VU to
equal -18 dBFS. For analog PPM's, keep the 0 PPM = -9 dBFS level. During production, avoid modulating hot all the time.
But at the same time do not hesitate to use all that headroom. If you are using a digital peak meter next to the other ones,
ATSC and EBU allow peaks to reach almost 0 dBFS, so don't worry about short peaks above -9 dBFS.

The key to almost automatically achieve consistent results without using meters, is to adopt the film postproduction
practice of aligning the monitor gain to a fixed acoustic level. In the broadcast case, the EBU tech 3276 document
prescribes to align a -18 dBFS (rms measured) pink noise track to a sound pressure level of 82 dBA per speaker for stereo
or 78 dBA per speaker for 5 channel surround. If you prefer to have your monitor SPL a little lower, just note the deviation
from the calibrated level for later reference. The alternative is to simply normalize a well known file to -23 LUFS, play it
back and set the volume control to your preferred listening level. The main concept is to now mark the monitor control
position and work at this reference level position 90% of the time or more. Your ears will tell you how loud you should



mix, you don't need a meter for that anymore. When you are satisfied with your mix, edits, dynamics and overall sound,
just bounce the result to a temporary file, let LevelOne analyze and process the file according to your preset target level
and your file is finished for release. After some practice you will note the necessary adjustment by LevelOne will be
minimal.



System Requirements

Recommended System Requirements

Windows

XP (x86), Vista (x86) or Windows 7 (x86)
Microsoft .NET installed
System Memory 512 mb
Available disk space: approximately 20mb

Mac

Intel only
OSX 10.5 or Higher
System Memory 512 mb
Available disk space: approximately 20mb



Installation

Windows

After downloading the setup file, double-click it to start the installer. You might see a general security warning that the
file is downloaded from a website. If so, just press the "run" button. The installer will guide you through the install
process. You don't need to change any of the settings unless you wish. When finished you may remove the setup file and
start the application by clicking on the LevelOne icon on the desktop or the start menu.

During the first start of LevelOne the default presets will be created. If these files are removed they will be recreated
during the next start of the program. If you change the presets they will not be replaced when LevelOne is updated. The
presets and settings are stored in the user folder: "C:\Documents and Settings\All Users\Application Data\Grimm
Audio\LevelOne" (under XP) or "C:\ProgramData\Grimm Audio\LevelOne" (under vista/win7), since the "applications data"
folder is hidden by default you may need to enter this in the path bar. You can save and distribute files in the "Presets"
folder amongst installs.

Please note: LevelOne requires .NET to be installed. If you do not wish to install .NET you can install the "Microsoft Visual
C++ 2008 SP1 Redistributable Package (x86)". Which is a lot smaller (4mb) but installs everything needed to run LevelOne.

Mac

Download the DMG from the web shop. Open the disk image by double clicking it. You might see a general security
warning that the file is downloaded from a website. If so, just press the "run" button. Drag the icon to your Applications
folder to install the application. If you wish you can drag the icon to your dock for easier access. You can now remove the
LevelOne disk image if you like. To start the application click LevelOne in the Applications folder.

During the first start of LevelOne the default presets will be created. If these files are removed they will be recreated
during the next start of the program. If you change the presets they will not be replaced when LevelOne is updated. The
presets and settings are stored in the user folder: "~/Library/Application Support/Grimm Audio/LevelOne". You can save
and distribute files in the "Presets" folder amongst installs.

Registration

When you start the program for the first time it will automatically launch the registration wizard. This wizard will guide
you through the registration process. If you have had a previous version of LevelOne install on the system the wizard will
automatically adopt the settings of the previous installation.

Check for Updates

Select "Check for update on startup" in the "help" menu. You need internet access for this feature to function. When an
update is found during startup, please follow the instructions. Preset files from your current version will automatically be
imported into the new version.



Basic Operation

1: Click the Add button or select 'Add files to the list' from the file menu to add one or multiple files to the batch
list. You can also drag and drop files on the list itself. If you drag folders to the list, LevelOne will add all audio
files in the folder, and subfolders to the batch list.
2: Select the preset. If you run the program for the first time you will only see the factory presets. You can create,
edit and delete presets, please read the Presets Window section of this manual.
3: Click the "Analyse" or "Process" button.
NB If no particulair files are selected, all files will be analyzed and/or processed. Otherwise only the selected files
will be processed.

Depending on the selected preset, files and computer speed, processing can vary from seconds to minutes or even hours
(for large collections of big files). The current output folder (determined by the preset) can be revealed by selecting
"Reveal current export folder" from the View menu, or by pressing <alt-r>.



Main Window

The Main Window shows a list of all files imported and (soon to be) analyzed files. You can add files by clicking the folder

icon, select "Add file(s)" from the file menu or press <cmd-o> on mac or <ctrl-o> on pc. The easiest way is to drag files

from your computer into the list area.

You can also drag folders to the list. If you do so all audio files in the folder and it's subfolder will be added to the list. The

folder structure will be kept intact.

Supported file formats are wav, bwf, aiff, sd2 and flac in stereo, 5.0 and 5.1 surround. Surround audio can be in single

(multichannel) file format or multiple mono files. In the latter case, make sure the files have the right labeling:

filename.l.wav

filename.r.wav

filename.c.wav

filename.lf.wav

filename.ls.wav

filename.rs.wav

('.wav' can be '.aif' too)

The file list

In the first column the status of the file is indicated. During analysis and exporting it shows a small spinner indicating how

much of the file is analyzed or processed. When exporting fails it will display an exclamation mark. The file name is in the

second column or, if selected in the preset, first the source folder of the file is indicated. Dependent on the preset

settings, one or more of the following measurements will be on display in the subsequent columns:

LUFS: the Loudness Units level, relative to Full Scale

LU: the relative Loudness Units level, calibrated in the preset.

max M: the maximum Momentary loudness, measured with 400ms window.

LRA: the Loudness Range, based upon a statistical distribution of the Short term measurement.

max S: the maximum Short term loudness, measured with 3s window.

max PPM: the maximum Peak Program Meter level, calibrated in the preset.

max Sample Peak: the old style peak level, based upon maximum sample values.

max True Peak: the interpolated True Peak level.

Adjust: the amount of dB the file has been or must be adjusted for normalization according the preset target level

settings.

Most right, one has the option to view all kinds of file info such as file type, length, size, amount of channels, bit

rate, sample rate, date. This information is also available via the File Inspector (see the File Inspector section).

For the LU, max M, max S, LRA, PPM and True Peak columns a warning threshold can be set in the preset editor (read the

Warnings section under Presets). Warnings will be displayed as exclamation marks in the column that asks for your

attention.

Because of the 3 seconds window length, the LRA and max S calculation of short files has limited value. For files shorter

than 10 seconds, 'NA' is displayed in the LRA and max S column.

Post adjust view



After analysis one can toggle between pre and post view by using the 'Post adjust view' option in the 'file' menu or by

pressing the <Tab> key. When toggled the file list will show the LU, PPM and Peak values after the calculated adjustment

is applied.

Selecting

A file can be selected by clicking on it. Using the <shift> key one can select a row of files at once. Use the <ctrl> key on

windows or the <cmd> key on mac to (de)select multiple files by clicking each file. The up/down arrows, home/end and

the page-up/down buttons are also available for those who don't like mice. Files can be removed from the list by clicking

the remove button, selecting "Remove file(s)" from the file menu or pressing the backspace (mac) or del (pc) key.

Sorting

To sort the result in the table click the column title of the column you would like to sort. By clicking it once more you can

switch between an ascending and descending order.

File inspector

The list in the Main Window displays the most important information on the file. To view more details, select the file(s)

from the list you would like to inspect, then select "File Inspector" in the file menu, click the File Inspector button in the

list header, or press <cmd-i> on mac or <ctrl-i> on windows. For more information about the Inspector see the Inspector

chapter of this manual.

Presets

Below the file list at the bottom of the Main Window, there is a drop down menu with presets. One can edit and create

presets by selecting "<edit presets...>" at the bottom of the list. For more information about the presets see the Presets

section.

Analyse/Process

Depending on the preset the button next to the preset list is called "Analyse" or "Process". Analyse means the file will be

analyzed only. Process means the files will be analyzed, adjusted and exported.

Progress bar

At the very bottom of the Main Window you will find a progress bar. It will show you the overall progress of the total task

of all files to be analyzed or processed.



Export Data

In the 'File' menu you will find an option to save the results from the file list and inspector as a csv file (comma separated

values). The data can be used within a spreadsheet program for further examination.



File inspector Window

The File inspector shows all kinds of file details. One can select a file and then open the Inspector, but it is also possible to
select a different file when the inspector is opened. The Inspector can show information of one file or information of a
collection of files.

The file details presented by the inspector are:

Name: the file name
Folder: the folder where the file is located
Length: the duration of the file in hours:minutes:seconds
Size: the file size in MB
Date: the creation date of the file
Format: the type of the file (Wav, Aif, etc)
Sub format: word length, encoding structure
Channels: number of channels in the file
Sample rate: Samplerate in Hz
LUFS: the Loudness Units level, relative to Full Scale
LU: the relative Loudness Units level of the file
Maximum M: the maximum Momentary loudness, measured with 400ms window.
LRA: the Loudness Range, based upon a statistical distribution of the Short term measurement.
Maximum S: the maximum Short term loudness, measured with 3s window.
Maximum PPM: the maximum Peak Program Meter level of the file.
Maximum Sample Peak: the maximum sample peak value of the file.
Maximum True Peak: the maximum true peak value of the file.
In the bottom table the PPM, Sample Peak and True Peak levels of the separate channels of the file are indicated.

When multiple files are selected the file details in the Inspector are:

Name: the number of files selected
Folder: the folder where the files are located or "-" if there’s multiple folders of origin
Length: total length of all files in hours:minutes:seconds
Size: total size of all files in MB
Date: first and last creation dates of the files
Format: the type of the file (Wav, Aif etc) or "mixed" when multiple formats
Sub format: word length, encoding structure or "-" for multiple sub formats
Channels: number of channels in the file or "-" if multiple formats
Sample rate: Samplerate in Hz or "-" if multiple samplerates
All other measurements are comparable to the situation above with just one selected file, except the levels are
calculated for the combined files.

Selecting more than one file will display the approximate LU level of the combined files in the inspector. When the gate is
enabled the Loudness Units level of the combined files will be an estimate as the gate for each file is set individually. When
the gate is disabled the LU level of the combined files is precise.



Presets Window

All settings of the application are stored in presets. These presets can be created and recalled by the user, allowing fast
and easy switching between settings for common normalization tasks. LevelOne has a set of factory presets that cover the
most common jobs. They can not be editted, but one can create new presets based upon the factory version. If the factory
preset is redundant it can be deleted (mark however that an update procedure will put the factory presets back in place).
The factory presets are:

ATSC A/85 2009 [analyze]
ATSC A/85 2009 [process]
EBU PPM [analyse]
EBU R.128 mode [analyse]
EBU R.128 mode [process]
EBU R.128 max 8 M warning [analyse]
EBU R.128 max 8 M warning [process]
EBU R.128 max 20 LRA warning [analyse]
EBU R.128 max 20 LRA warning [process]

One can easily make a new preset by using an existing preset as a template. Do this by selecting this preset from the list
in the 'Edit presets' dialog. Then click the 'New' button. A new preset will be created that contains the same settings as the
selected template preset.

A preset can be edited by double clicking its name in the list or by selecting the preset and clicking on the edit button.

General

Preset name

The name of the preset. Please note you cannot overwrite the default preset names.

Peak Measurement

Digital processing of all kinds is abundant nowadays. Some of these processes introduce regular digital peaks that are
higher than the peaks of a 0 dBFS digital sine wave, when converted to analogue signals. These will make DA converters
like in CD players and media systems clip in unpredictable manner and distort the sound. Similar clipping occurs in
sample rate converters and lossy codecs like MP3. To avoid this problem, LevelOne uses an oversampling algorithm that
emulates the filters used in these converters and thus is able to measure the True Peak level of the file. The oversampling
algorithm is cpu intensive and therefore analyzing with enabled oversampling leads to longer processing times.

There are three choices for peak measurement in LevelOne:

Sample Peak: will show the maximum sample values. This is the digital peak level as indicated by the majority of
digital audio systems. The calculation of this peak level is very fast, but only recommended when you are certain
there is enough headroom.
True Peak Standard (BS.1770): will show True Peak levels using oversampling, conform the ITU BS.1770 "dBTP"
standard. This is the recommended setting for normal use.
True Peak Double Precision: will measure peaks at the highest precision, but with largely increased processing
time. This setting is recommended when normalizing heavily processed signals to the maximum level (0 dB).



Sample Peak

 

True Peak Standard (BS.1770)

 

True Peak Double Precision

LUFS Gate

Switch on/off the 'EBU R.128 Gate' for the LUFS measurement. The EBU R.128 loudness normalization standard

incorporates the use of a gate that pauses the measurement when the audio program falls below a certain level (10 dB

below the ungated LUFS loudness value) for longer than 400 ms. The purpose of this is to avoid 'silent' movies with lots of

low level fragments to measure relatively low and thus inadvertently receive a gain that provides too high dialog levels. If

the normalization has to comply with R.128 the gate should be engaged. It is advised to use the gate in almost every

situation, except perhaps when normalizing classical music where the silent parts do not play a background but a

foreground role.

Surround channel order

The LUFS measurement has a different weighting for the surround speakers. Therefore LevelOne must know the channel

order of multichannel files in your facility. There are three options:

SMPTE/ITU (L-R-C-Lfe-Ls-Rs)

Film (L-C-R-Ls-Rs-Lfe)

DTS (L-R-Ls-Rs-C-Lfe)

View

In the View tab the various column types to be on display can be selected.

Calibration

Reference level calibration

Both LU and PPM have to be calibrated to a certain level. EBU recommendations prescribe 0 PPM to equal -9 dBFS and 0 LU

to equal -23 LUFS.

Target

Target level (adjust)

LevelOne is able to automatically normalize files and save them in a new folder. To control the normalization process a

target level must be set. There are three options:

LU: targeting a LU level, for example 0 LU according to the EBU R.128 Recommendation

PPM: targeting a PPM level, for example 0 PPM according to the "old" EBU Recommendations



Peak: targeting a True Peak or sample peak level, depending on the selected algorithm in the preset:
dBFS: sample peak, using no oversampling. This is traditionally referred to as "normalizing". We discourage
to use 0 dBFS as a target level because signals may clip during conversion to the analogue domain.
dBTP: True Peak. This is recommended as a replacement for "traditional" normalization as this will still
normalize using peaks but calculates the headroom needed for interpolation.

Notify when finished processing

If this option is set, a sound will be played when all selected files are processed.

On Mac OSX LevelOne supports Growl notifications, even when the ‘Notify’ option is not selected. Settings for the Growl
notifications can be found in the system preferences under Growl. For more information about Growl visit
http://growl.info/.

Warn when exceeding levels after adjustment

Use this option to warn when a certain level is exceeded. An exclamation mark will be shown in the column that exceeds
the prescribed level. It is possible to set warnings for each measurement method separately. The default warning levels
have been set to numbers that some broadcasters have selected as a limit, such as max M = +8 LU for commercials and
promos or max LRA = 20 LU for other program material. Default presets with these warnings are also available.

Note that LevelOne will never export at the target level if this means the peak levels of the file will exceed a 0 dB sample
peak or True Peak level. If this situation occurs, LevelOne will use and display the maximum level it could reach (closest to
the target level) and indicate an exclamation mark in the adjust column to draw your attention.

Export

This tab specifies if and how LevelOne exports copies of the files.

Export adjusted copy

When enabled the file will be adjusted and saved to a new location. The original file will stay intact. When exporting is
disabled the Main Window will display a button called "Analyse" as files will be measured only. When exporting is enabled,
the Main Window will display a button called "Process", indicating that files will be measured, adjusted and saved.

From the main display, the current output folder can be revealed by selecting "Reveal current export folder" from the View
menu, or by pressing the shortcut <alt-r>.

Export Settings

File name tag

You can automatically add a custom tag at the end of each exported file, indicating that the file has been processed and
adjusted to the selected standard.

Output locations

Specifies in which folder the exported file(s) will be saved.

Replace existing files

This option selects if existing files will be replaced. There are three options:



Yes: replaces files without a warning.

No: skips existing files without a warning. Skipped files are indicated in the main screen, using an exclamation

mark in the status column of the file.

Ask: LevelOne will ask you what to do for each file that already exists.

Word length

Specifies the word length used for the exported file. Files will be truncated with flat 2LSB TPDF dither.

There are three options:

16 bit

24 bit

original (this will export the new file using the word length of the original file)

Export PDF file with results

When this option is selected, a pdf file with the file name is placed next to the exported file. It contains all pre and post

adjust analysis data of the file. This pdf can be used for later reference and is also beneficial when accessing the exported

files from another computer in a networked environment.

Export as BWF v2 with EBU loudness metadata

BWF v2 of 2011 added loudness metadata to the bext (main) chunk of a BWF file. The following loudness metadata is

defined: LUFS, max M, max S, LRA and max True Peak level. When a BWF file that has this metadata is imported into

LevelOne, the stored values are shown in grey in their corresponding columns. When exporting a BWF format file,

LevelOne will convert it to BWF v2 format and store the measured values in the metadata fields. The "Export as BWF v2

with EBU loudness metadata" option allows to convert files of any audio format (wav, aiff, sd2, flac) into BWF v2 format

with loudness metadata.



References

http://tech.ebu.ch/loudness provides all kinds of information about the EBU R128 broadcast loudness recommendation.

The official R128 documents and guidelines can be found, as well as introduction papers and videos.
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Appendix 1 - Factory Presets

Setting EBU R128 EBU PPM ATSC A/85 2009
Peak Mode BS.1770 Oversampling Sample BS.1770 Oversampling
Gate On Off Off
Channel Order SMPTE/ITU SMPTE/ITU SMPTE/ITU
LU calibration -23 LUFS -23 LUFS -24 LUFS (= LKFS)
PPM Calibration -9 dBFS -9 dBFS -9 dBFS
Target: 0 LU 0 PPM 0 LU
Notify On On On
Warn Exceeding LU, Max M,
LRA, Max S, PPM dB

Off / max LRA 20 LU / max M
+8 LU Off Off

Warn Exceeding Peak -1 dB BS.1770 Oversampling Off -2 dB BS.1770 Oversampling



Appendix 2 - Supported File Formats

The currently supported file formats.

Importing

format extension mono stereo multichannel Bitrate

SGI/Apple aif, aiff + + + 16 Bit / 24 Bit

Microsoft / SphereNost wav + + + 16 Bit / 24 Bit

PCM Broadcast wave wav, bwf + + + 16 Bit / 24 Bit

Sound Designer II SD2 + + - 16 Bit / 24 Bit

FLAC flac + + + 16 Bit / 24 Bit

Exporting

format extension mono stereo multichannel Bitrate

SGI/Apple aif, aiff + + + 16 Bit / 24 Bit

Microsoft / SphereNost wav + + + 16 Bit / 24 Bit

PCM Broadcast wave wav, bwf + + + 16 Bit / 24 Bit

Sound Designer II SD2 + + - 16 Bit / 24 Bit

FLAC flac + + + 16 Bit / 24 Bit


